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Além do visual 2D

Programa gera imagens virtuais para Web
Usando a tecnologia QuickTime VR, que gera uma
imagem em 360° de um objeto ou cendrio, 0
Spinlmage DV 0Bject Kit utiliza um método mais
simples para conseguir filmes tridimensionais para
serem colocados na Internet.

0 processo de captura das imagens ¢ simples e rapi-
do, segundo a Spinimage: usa-se uma mesa motori-
zada, uma camera DV FireWire ligada ao Mac e s6. O
programa Autolycus Spinlmage converte o filme gra-
vado em um arquivo QuickTime VR ou num objeto
HTML que pode ser transferido para a Internet.

0 custo do kit (que ndo inclui computador e came-
ra digital) é de US$ 399,95.

Spinlmage: . spinimaged.com

WehStar é “carbhonizado”

4D apresenta na WWDC o WebStar V

e o 4th Dimension v.6.7 para Mac 0S X

Desde setembro de 1999, as Forgas Armadas norte-
americanas trocaram a plataforma de seus servi-
dores mais invadidos, passando do Windows NT
para 0 Mac OS rodando o servidor WebStar.

Em margo do mesmo ano, os servidores que
rodavam em Macintosh passaram intactos por um
teste de fogo, quando um grupo de hackers
brasileiros tentou ataques contra o site das forcas
armadas americanas. Esses mesmos hackers
obtiveram sucesso ao acessarem diversos outros
servidores governamentais no mesmo periodo,
incluindo Bureau of Land Management's National
Training Center e dois outros servidores Web das
forgas armadas norte-americanas. Infelicidade deles,
que ndo estavam utilizando Mac OS com WebStar
nessas magquinas.

Tudo isso é uma deixa para dizer que a 4D apre-
sentou na WWDC 2001 a mais nova verséo do seu
servidor de web para Macintosh. A Worldwide Deve-
loper Conference é a maior convencdo de desen-
volvedores para a plataforma Mac do planeta.

0 4D WebStar V (versdo 5) mantém todas as faci-
lidades da interface administrativa e ainda tira
proveito da velocidade e estabilidade do Mac OS X.
Também responsavel pelo software 4th Dimension,
a 4D apresenta o 4th Dimension v.6.7 para Mac 0S
X, oferecendo um ambiente de desenvolvimento
mais flexivel, novas ferramentas para Web e um
excelente suporte para desenvolvimento de grandes
bancos de dados.

Serd que o Macintosh continuara tao seguro rodando
Mac OS X com WebStar ou Apache? S6 o futuro dird...
Exército dos EUA:
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Parte integrante da revista Macmania
Nao pode ser vendido separadamente

Montar um estudio digital € mais
facil e barato do que parece

por Marcio Nigro

Ha quase trés anos, na
Macmania (na his-
térica edigdo
5I), escrevi
uma matéria
de varias pagi-
nas falando
sobre como mon-
tar seu esttdio digital.
Nela, descrevi os equipa-
mentos necessarios para os
iniciantes enfrentarem tal
empreitada, como placas de dudio,
interfaces MIDI, mesas de som etc.
Pois bem, hoje poderiamos resumir
quase tudo isso em apenas umas poucas
letras: Digi oor.

Definitivamente, a Digidesign foi feliz ao
criar um sistema como o Digi oo1. Mais do
que isso, demonstrou estar atenta as neces-
sidades dos musicos e profissionais da 4rea
de dudio que querem participar do fantasti-
co mundo sonoro digital em 24 bits, mas
que ni3o tém poder de fogo para
adquirir um sistema
avancado como
o Pro Tools
e nem se
contentam com
a boa e velha —
porém limitada
— Audiomedia
II1. S6 que a
Digidesign foi
mais longe e lan-
¢OU Nao apenas um
produto que conver-
te e grava audio com
resolucdo de 24 bits,

mas também um sistema completo e quase
auto-suficiente, que dispensa até mesmo
o mixer e a interface MIDI externos.
Ou seja, junte o Digi oo1, um
sintetizador MIDI multi-
timbral, mais algum
equipamento
para moni-
torar o
audio, e
vocé ja
terd um
esttdio
digital de res-
peito. Isso tudo
pelo preco de R$
3.120, 0 que ndo é nada
mal por tudo que é ofereci-
do, conforme veremos a seguir.
O Digi oo1 é um sistema composto de duas
pecas: uma placa
de dudio PCI e a
I/O Box (caixa
de entrada e
saida). Instale
a placa e co-
necte o cabo
que interli-
ga as duas
partes, € o
produto
ja estara
funcio-
nando, uma vez que
nio necessita de um cabo
de forca proprio, pois tira a ener-
gia necessaria do proprio computador. A
caixa inclui o software Pro Tools LE 5.1,
completando o “trio parada dura”.
MacPRO*55




Digi 007 s

A 1/O Box

E na I/O Box que reside parte do segredo do Digi oo1. Nela vocé encontrara os seguintes componentes:

Frente

Ganho de entrada 1 -
As entradas da Digi 0o1
possuem um pré-amplifica-
dor para controlar o nivel
de sinal de entrada, o que é

Modo de monitora¢io —
Quando este botdo € pres-
sionado, a I/O Box passa a
monitorar as entradas 3/4,

Atenuador 1 — Para aco-
modar as variagoes de

nivel de sinal de microfone P Entrada, mesmo que o computador Power — Indica que a I/O
e linha, o produto dispoe fundamental LS almen- atenuador esteja des,l’g“do- ASS”",‘] vocé Box estd ligada (e conecta-
de atenuadores de -26 dB te em gravacoes captadas e ganho 2 pode usd-la para ouvir um da ao computador)

para as entradas 1 € 2 por microfones

CD player ou sintetizador
sem ter que ligar o Mac

Mic/Line | |

Volume do fone

de ouvido Saida de fone

de ouvido -
Padrdo P1 estéreo

Entrada de microfone e linha 1 -
Nas duas entradas vocé pode
ligar microfones ou outros instru-
mentos nas entradas XLR (Canon)
balanceadas ou P1 (banana)
nao-balanceadas

Phantom Power —
Microfones condensadores
necessitam de fonte de ener-
gia de 48 volts para funcio-
nar. E para isso que serve o
botdo Phantom Power

Indicador do
Phantom Power —
Fica aceso quando
o Phantom Power
estd ligado

Monitor de volume —
Controla o volume geral da
saida de monitoracdo

Traseira

Entrada e saida digital S/PDIF -

A interface S/PDIF (Sony/Philips Digital
Interface Format) pode ser usada por mesas
digitais, gravadores DAT e outros dispositivos.
Sdo dois canais de dados digitais que utilizam
conectores RCA com cabo coaxial de 75 ohms
para evitar interferéncia de frequéncias de
rddio. A partir dela, vocé pode gravar e moni-
torar até dois canais de dudio (estéreo)

Entradas analogas 3 a 8 — Essas seis
entradas aceitam conectores P1 e ndo pos-
suem controle de ganho. Vocé pode ligar
qualquer instrumento nelas e monitord-lo
ou gravd-lo a partir do Pro Tools ou outro
software compativel. Todas as entradas e
saidas do Digi 0o1 incluem conversores
andlogo-para-digital de 24 bits

Saidas de monitor —
Podem ser conectadas a
monitores ativos (preé-
amplificados), um amplifi-
cador estéreo ou até mesmo
um aparelho de som.
Essas saidas ddo “vazao”
apenas ao dudio direciona-
do para as saidas 1 € 2

Saidas andlogas 3a 8 —
Saidas ndo-balanceadas que
podem ser titeis para enviar,
por exemplo, um sinal para

processadores de efeitos
externos e depois roted-lo de
volta para alguma entrada

andloga da I/O Box
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Conector do computador —
Conecta a I/O Box a placa PCI

Entrada e saida MIDI — A Digi oo1 possui uma entrada e uma

saida MIDI (Musical Instrument Digital Interface) que permite

controlar um sintetizador ou outra fonte externa de timbres, por
exemplo. Se vocé quiser conectar mais de um equipamento ao

mesmo tempo, precisard de uma interface MIDI com mais

entradas e saidas. Para fazer funcionar a interface MIDI da

I/O Box com o Mac, € necessdrio instalar e configurar o progra-

ma OMS, que € instalado junto com o Pro Tools

Foot switch — Se vocé conectar aqui algo
como um pedal de sustain daqueles usado
em sintetizadores, por exemplo, poderd
controlar o ponto de inicio e de término de
uma gravagdo (punch-in e punch-out).
Isso € importante para quem trabalha so-
zinho, permitindo disparar o “Rec” com o
PE, sem que VOCE precise se preocupar em
ficar apertando teclas no computador ou
mexendo no mouse enquanto se prepara
para cantar ou gravar algum instrumento

Saidas analogas principais 1 e 2 —
Essas saidas sdo balanceadas e propi-
cias para passar a mixagem para
algum dispositivo externo de gravagio
estéreo, como um DAT, por exemplo



Placa PCI

A placa PCI do Digi oor é o coragio de todo o
sistema. Nela vocé vai encontrar o conector
para interligi-la 3 I/O Box e a entrada e saida
optica ADAT (Alesis Digital Audio Tape). A
interface ADAT permite que vocé tenha mais
oito entradas e saidas digitais para interligar o
Digi oor a um gravador ADAT ou outro equi-
pamento compativel com esse formato (algu-
mas mesas digitais permitem incoporar esse

tipo de interface). Fazendo as contas, vocé pode

perceber que o Digi oor oferece até 18 saidas e
entradas de dudio independentes (oito anilo-
gas, oito ADAT e mais duas S/PDIF), o que é
bem razoavel para um produto desse porte.

Pro Tools
Como ja disse, o Digi oo1 vem com o softwa-
re Pro Tools 5.1 LE, edi¢do voltada para quem

nio tem o sistema de hardware Pro Tools, que

¢ bem mais caro.

O software Pro Tools é certamente um dos
mais conhecidos editores de dudio digital do
mercado. Mas, recentemente, a Digidesign
viu que estava perdendo terreno para outros
programas, como Logic Audio e Cubase, que
possuem ferramentas para manipulacio de
MIDI muito mais poderosas e ainda contam

com plug-ins de efeito em tempo real. Assim,

foi dada uma reformulada geral no Pro Tools,
que na versdo 5.0 ja incluia recursos muito
melhores de controle sobre sequéncias MIDI
e com os plug-ins RTAS.

Quem conheceu as versdes anteriores do Pro

Tools sabe que as ferramentas para MIDI eram
um tanto espartanas, de modo que muitas pes-

soas acabavam utilizando outros programas
para a tarefa e depois exportavam o MIDI para
o programa da Digidesign. Agora, vocé pode
contar com uma grade de tempo, marcadores,

notacdo de compasso e muitos outros recursos.
Mas esse nio é o ponto forte do Pro Tools, pois

em termos de recursos de MIDI o Logic e o
Cubase ainda dio de dez.

Pessoalmente, ndo sou grande fa do Pro Tools

(Sou “logic-audiano” convicto), pela simples
questdo de que o considero mais como um

programa de gravagdo/edi¢io do que uma fer-

ramenta de criatividade. No entanto, é inega-

vel que n3o existe nada mais estavel e integra-

do do que usé-lo com o hardware da prépria
Digidesign. No caso da Digi oor, isso ndo é

excecdo, e a versdo 5.1 LE funciona impecavel-

mente. Certamente, nenhum outro programa
vai ter uma performance tao boa com esse
mesmo equipamento. Vocé pode abrir diver-

sos canais de dudio e de MIDI, aplicar efeitos,

equalizar, comprimir e tudo mais como se
vocé estivesse numa mesa de som convencio-

nal, com direito até a saidas auxiliares (Aux) e

Bus. Também é possivel criar canais para
monitorar os instrumentos conectados as
entradas da I/O Box. Assim, vocé pode tratar

Digidesign

Digi 001

SO

Digidesign: . digidesign.com
Quanta Technology: 0800-55-4644
Preco: R$ 3.120,00

_2;- Pro: Inclui quase tudo o que vocé precisa
para montar um estudio de pequeno porte;
otima qualidade de som; ndo necessita de
caho e fonte de forga

:} Contra: Requer 196 MB de RAM e um G4
para tirar o maximo proveito; um botdo de
forca ndo faria mal; o Pro Tools 5.1 LE esta
limitado a 24 canais de audio mono

o sinal das entradas andlogas como se fosse
um outro canal qualquer, facilitando em
muito a mixagem. As grava¢des podem ser
feitas em 16 bits (arquivos menores) ou 24
bits, com sample rate de 44.1 ou 48 kHz.

Um dos grande lances incorporados ao Pro
Tools a partir da versdo 5.0 foi a introdug¢do dos
plug-ins RTAS, que funcionam em tempo real,
de maneira similar aos plug-ins VST, que nao
sdo suportados pelo programa da Digidesign.
Infelizmente, ndo da para se alongar muito
sobre o Pro Tools, porque isso ji daria um
artigo a parte.

Quase ia me esquecendo: a Quanta, que dis-
tribui e revende o Digi oo1, também incluiu
na caixa a fita de apresenta¢do do produto
(software e hardware) dublada em portugués.
Por questdes emocionais, acabei testando o
Digi oo1 com o Logic Audio Platinum 4.7 e
constatei que o sistema funcionou surpreen-
dentemente bem com o programa da Emagic,
tirando proveito de todos os recursos do pro-
duto da Digidesign, embora a performance
nio seja tdo boa quanto a do Pro Tools.

Para ninguém dizer que estou rasgando
muita seda para a Digidesign, ai vai uma ma
noticia: o Digi oor1 requer pelo menos 128
MB de RAM (192 MB é o recomendado) e
um processador G4, se vocé quiser usar 24
canais de dudio, plug-ins e tudo mais (mas da
para rolar até num Mac com processador
6o4e de 200 MHz). Além disso, vocé esta
limitado a 24 canais mono no Pro Tools 5.1
LE e mais 16 canais auxiliares.

O veredito

Trabalho ja ha alguns anos com o mixer digi-
tal Yamaha O3D e as placas Audiomedia III e
Audiowerk8, esta da Emagic, e considerava
que tirava um som legal desse conjunto. Isso
até testar o Digi oo1, que chegou humilhan-
do minha turma. Os conversores de 24 bits
do Digi oor1 realmente fazem uma grande
diferenca para quem trabalhava no terreno
dos 16 bits. Agora que mudou a minha refe-
réncia sobre o que é bom ou ruim no mundo
do dudio digital, certamente vou ter que to-
mar alguma providéncia para nio ficar suspi-
rando o dia todo, lembrando meus bons
momentos com o Digi oor.

MARCIO NIGRO

Mac 0S X e Java, mais

juntos que nunca

Borland mostra versdo beta do JBuilder 5

A Borland esta de olho no mercado Mac. Ela apre-
sentou a versdo beta do seu programa de desenvol-
vimento em Java, o JBuilder 5.0, durante a WWDC
deste ano. A partir de agora, a Borland vai atacar
em todas as grandes frentes: Solaris, Linux,
Windows e Mac 0S X.

Segundo a Borland, o sistema operacional da Apple
leva vantagem em relagéo a seus concorrentes por-
que tem alta integragcdo com o padrdo Java 2 no
proprio sistema, incluindo a versdo cliente da
méaquina virtual HotSpot. O JBuilder permite criar
aplicativos Java (Java 2 Standard Edition) com a
nova interface Aqua. A empresa ainda nao definiu
uma data de langamento para a verséo final do
JBuilder 5.0 para Mac 0S X, mas acredita que ainda
este ano chegue as prateleiras.

Borland: s borland.com.br

JBuilder: wwe borland.com/ jbuilder/mac

FileMaker chega ao X

Banco de dados é “carbonizado”

A principal novidade da versdo 5.5 do FileMaker ¢é
que ele agora € “carbonizado” (adaptado para o 0S
X). Além da interface Aqua, o programa utiliza o
QuickTime Import Engine nativo do Mac OS X para
importar arquivos PDF (contendo graficos ou texto)
como filmes QT, possibilitando anexar esses arquivos
em uma entrada (record) e navegar dentro deles.
Agora tambem & possivel modificar bancos de dados
importados de outros aplicativos com o padrdo ODBC
(Open Database Connectivity), como Access e Oracle.
0 prego do FileMaker é de US$ 249 (usuérios re-
gistrados pagam US$ 149). Os outros produtos da
FileMaker, hoje uma subsidiaria da Apple, sdo ver-
sOes do banco de dados para servidores e desen-
volvedores (para criar aplicativos com o FileMaker),
mas nenhuma delas ainda esta “carbonizada”.
FileMaker: . filemaker.com

Uma maozinha para os
desenvolvedores de jogos

Apple publica na Internet nova

tecnologia para controladores

Quando a Apple avisou, no ano passado, que abando-
naria o InputSprocket (AP! utilizada para usar controla-
dores de jogos) no Mac OS X, alguns desenvolvedores
ficaram assustados e previam uma era negra para
games no novo Sistema operacional. At a semana
passada, ainda ndo existia nenhuma dica da Apple
sobre 0 que substituiria esse componente. Porém, fez-
se luz nas trevas com a chegada do HID Manager.
Essa nova tecnologia de suporte a controladores de
jogos € um recurso especial para os desenvolvedores
preencherem a lacuna deixada pelo InputSprocket.
No site aberto para desenvolvedores, as informagoes
estdo divididas em dois formatos: HTML (para visua-
lizacdo online) e PDF. Também esta disponivel para
download um codigo-exemplo gratuito.

Segundo a Apple, o HID Manager ainda esta em
fase de desenvolvimento e pode ser mudado. O
codigo-exemplo foi escrito para funcionar no Mac
0S X final (ou Golden Master) e pode n&o ser com-
pativel com as versoes beta do sistema operacional.
Site para desenvolvedores: http://developer.
apple.com/techpubs/macosx/Kernel/kernelhtml



Construa 0 seu tocador de MPS3

Um dos meus passatempos preferidos é
fazer musica (ou barulho) no Mac. Depois de
tantas noites mal dormidas, consegui acumu-
lar uma boa quantidade de arquivos de musi-
ca. E quando se fala em musica no Mac, o
primeiro nome que vem a mente é MP3.

Por isso, nosso projeto deste més serad cons-
truir um tocador de MP3. E claro que nio vai
ser nenhum iTunes, mas permitird que vocé
crie uma lista das MP3 para ouvir. E, se esti-
ver usando o REALbasic 3, o tocador de MP3
funcionara tanto no Mac OS classico como
no novissimo OS X.

Para inicio de conversa, vamos comegar
criando a interface. Depois de abrir o
REALbasic, escolha o comando Botdo (que
tem um OK escrito) na Palete de Ferramen-
tas. Este serd o botdo para tocar musica.

5] ‘Properties B Se o botao nio
Il M| estiver selecionado,
Mame Tocar Button i
e clique nele. No lado
Super PushButton ¥| || direito da tela vocé
Position 4
Lot 3 verd uma palete
Top 21 chamada
‘;l\’i_dt'?t SE Propriedades
] .
T 0 (Properties). Ela
LockTop O permite que vocé
LockEIghE O mude algumas
LockBottom O o
B caracteristicas do
Caption Tocar []| || objeto. Modifique o
gefﬁu:t O nome (Name) do
Ance ~
et o botdo para
Wisible o TocarButton e a
g::rUT:IEHelp % propriedade
DisabledBelloanielp &l || Caption para Tocar.
AutoDeactivate [ A posicio dele na
Font .
TextFont System [ janela fica por L.
Textdize 12 conta da sua criati-
Bold O vidade.
Italic O |
Underling O -l

Usando a mesma técnica, adicione outro
botdo com a propriedade Name igual a
PararButton e Caption como Parar.
Continuando, escolha agora um comando
Check Box (o que tem um simbolo de checa-
do) e digite a propriedade Name igual a
RepetirBox e a propriedade Caption como
Repetir. Depois, vamos acrescentar um
comando ListBox (hd duas op¢des, uma com
duas colunas e outra com uma s6. Escolha a
coluna simples) com a propriedade Name
Musicalist e, por fim, um comando
MoviePlayer (o que tem o simbolo do
QuickTime) com a propriedade Name igual a
MusicaPlayer. Organize todos esses elemen-
MacPR0*58

por Gilbert Canaan
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tos na janela como é mostrado (ou entdo,
aonde vocé achar melhor).

O MusicaPlayer (o controle MoviePlayer
que criou) é a alma do programa. Gragas ao
QuickTime 4, vocé poderd tocar arquivos MP3
com seu programinha esperto. Os botdes
Tocar e Parar irdo controlar o MusicaPlayer,
mas, infelizmente, o coédigo que vocé escrever
depois ficard confuso e impraticavel se o
usudrio puder mexer nos controles do
QuickTime. Para resolver esse problema, cli-
que no controle MoviePlayer e mude a sua
propriedade Controller para Nenhum (None).

Agora vocé precisa criar um item de menu
que permita ao usudrio ler e carregar os
arquivos que irdo tocar (as musicas).
Selecione a Janela » Projeto (Window »
Project) e dé um duplo-clique no item Menu.
Uma vez aberto, clique no menu Arquivo, e
depois no espaco em branco abaixo do item
de menu Encerrar.

Vamos criar o menu Abrir MP3... com o
atalho @©. Um item de menu com reticén-
cias significa que quando o usudrio o selecio-
na, uma caixa de didlogo aparece (neste caso,
a caixa de didlogo AbrirDocumentos).

Application Menu
Edit

& File

Na janela de Propriedades, escreva Hame =
AbrirArguive, Text = Abrir MP3... e
em Behavior, a letra . Arraste o novo item pa-
ra cima do item de menu Encerrar (Quit) para
colocd-lo no lugar onde fica geralmente. Salve
tudo (se vocé ja ndo fez isso antes, é claro).

€

Muito bem, a interface estd pronta. Vamos
para a hora da digitacdo do cdédigo. A funcio-
nalidade central do MP3 Player é o controle
ListBox no centro da janela, que mostrara
a lista de musicas carregadas. Porém, é
preciso armazend-las para que o programa
possa toca-las.

O REALDbasic pode criar propriedades adicio-
nais para o armazenamento de tais itens.
Entdo, dé um duplo-clique na interface (nio
em cima dos controles e botdes) para abrir o
nosso amigo Editor de Cédigo. Selecione
Editar » Nova Propriedade... (Edit » New
Property...) e digite o seguinte codigo:

musicas (100} as

movie

ODOEONSF O-frrrrpy

O que essas duas propriedades significam? A
primeira (“musicas (100) as movie”) diz ao
REALDbasic que a lista de musicas pode conter
de o a 100 arquivos. A segunda, que a pro-
priedade Tocando armazena duas alternativas
True ou False (verdadeiro ou falso); isso é
usado para saber se o MP3 Player estd tocan-
do uma misica ou n3o.

S6 para ver se estd tudo dando certo, execu-
te o programa. Selecione Depuracio »
Executar (Debug » Run). Esta tudo joia, s6
que nada funciona! Agora é a hora de adicio-
narmos codigo.

Antes de encerrar o programa, note que o
item de menu Abrir MP3... estd desabilitado.
Para implementar essa funcao, volte para o
REALDbasic (feche o programa de MP3) e
abra o Editor de Cédigo. No painel do lado
esquerdo, vocé vai encontrar um item cha-



mado Eventos (Events — o que tem um dedo
azul perto dele). Clique no tridngulo para ver
os eventos nos que vocé pode alterar.
Selecione o item EnableMenultems e digite
o codigo:

if Musicalist.lisvCount < 104

then
ArguivoAbrirMP3.Enabled = Trus
2lze
ArguivoAbrirMP3.Enabled = False
end if

Agora, adicione o codigo para abrir a caixa
de dialogo para abrir documentos. Selecione
Editar » Novo Handler de Menu... (Edit »
New Menu Handler), escolha o item
ArquivoAbrirMP3 e clique em OK.

Digite o cddigo:

f Az FolderIten
Tim m Az Movie
fhpenFolderIteniaudic/npag”
if £ <5 nil then
m = f.épenhsMoviel]
musicasiMusicalise.Listlounti=n
Musical Mame?

Fiidi

igt.AddRowif

end if

Na verdade, o programa ainda n3o vai
deixar vocé abrir nada: o problema é que
vocé ainda nio disse ao programa o que
é um arquivo de MPEG (0 mesmo que MP3).
Entdo, selecione Editar » Tipos de Arquivo
(Edit » File Types...). Na caixa de dilogo, cli-
que no botao Adicionar (Add) e no menu
popup selecione Audio /MPEG. Configure o

Adicionar musicas na lista é legal, mas e
se vocé carregou aquele arquivo e depois nio
quer mais ouvi-lo? A melhor maneira de apa-
gar um item da lista é usar a tecla [Delete),
certo? Dé um duplo-clique na Lista de Musica
na interface e, no Editor de Cédigo, selecione
o item keyDown e digite o codigo:

Bim minhaMusica, i As Integer

Musicalist.removeRowiminhaMusica:
for 1 = minhaMusica %o
Musz Lizg.Listlount

end if
end if
Agora sim, o programa estd quase pronto.

Vamos fazer isso em trés passos. Primeiro, diga
ao botdo Tocar para tocar. Para fazer isso, dé um
duplo-clique no botdo Tocar e digite o cédigo:

Dim musicaSelecionada As Integer
> O then
trcaﬂdo = Truse
if Musicalist.listindex = -1
then
Musicalist.Zelected = Trus
slze
icalelecionada=musicalist.Listind
Musicalist.selec-
tedimusicalelecionadai=falzse
Musicalist.Zelectedimusicalelecionad
31=Trus
end if
end if

Agora nés queremos que a MusicaList
toque a musica correta se a sele¢do for trocada
(por exemplo, quando vocé deleta uma musi-
ca) enquanto o Player estiver tocando. Dé um
duplo-clique na MusicalList e digite o codigo
no item Change do Controle MusicaList:

if Me.lListindex <>-1 and tocando
then
tocando=falze
MusicaPlayer.stop
MusicaPlayer.Position=0.0

zicaPlayer.Movie=Musicas

HugicaPlayer.Play
tocando=Trus
end if

A seguir, vocé precisa dizer ao programa
para avancar para a proéxima musica quando
uma termina. Quando o programa alcanga o
fim da lista, se o checkBox Repetir estiver
marcado, ele comega a tocar do inicio da
lista outra vez. Para fazer isso, dé um duplo-
clique no MusicaPlayer, depois no item Stop
e digite o codigo:

Dim prowimabusica As Integer

if tocands then
prozimaMusica =
musicalist.listIndex+l
if
proxzimaMusica=Musicalist.Listlount
than

proximaMusica=0

if repetirBox.V¥alue = False

Musicalist.ZelecvediMusicalisv.Listl

-
B2
ndexi=False

L

Musicalist.Zelecte
rus

end if

dipro=imaMusical=T

Para terminar, vamos implementar o bo-
tao Parar. Dé um clique-duplo nele para abrir
o Editor de Codigo e digite no item Action:

a=f3l:
MusicaPlayer.Ztop

Bulld Application
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Finalmente, crie o aplicativo auto-executa-
vel, selecionando Arquivo » Construir
Aplicativo (File » Build Aplication).
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l

Muito bem, vocé conseguiu! Agora podera
experimentar e ouvir todas as suas musicas
favoritas no seu proprio tocador de MP3. E,
o que é melhor, ele pode funcionar inclusive
no Mac OS X.

Nao, ndo precisa agradecer.

GILBERT CANAAN
E fundador da Canvicz Software e trabalha
com Mac desde 1988

Colaborou Sérgio Miranda
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